How To Develop Streaming Multimedia Lecture Presentations.

This paper shows instructors how to develop their own streaming multimedia presentations that can be loaded onto a school's server and played by students over the Internet. Topics covered include: the use of courseware to create an online course or to complement face-to-face instruction; features of Oncourse, Indiana University's proprietary version of courseware; advantages and disadvantages of Microsoft's advanced streaming format (.asf); using Windows' Sound Recorder to record lectures; compressing PowerPoint presentations; and using HTML formatted files. Sample screenshots are included. (MES)
How to Develop Streaming Multimedia Lecture Presentations

By Thomas Keefe
How to Develop Streaming Multimedia Lecture Presentations

By: Thomas Keefe
Track 2 - Innovation and Future Implementation in Instructional Technology
Interest: Faculty :: Workshop :: Level: Beginner

Abstract

I teach undergraduates at Indiana University Southeast's School of Business - a regional IU campus. Since 1999, I have used streamed lectures in my classes that I created myself with Power Point. McGraw Hill has used these lectures as part of course packs for an Organizational Behavior textbook. The session is intended to show instructors how to develop their own streaming multimedia presentations that can be loaded onto a schools' server and played by students over the Internet.

Proceeding

The Challenge

Can the traditional classroom experience face up to the challenge of the Internet? The use of the Internet in a hybrid course allows an instructor flexibility to rethink how best to teach. In this workshop, participants will learn how to develop streaming media presentations based on readily available, easy to use technology. Specifically, Microsoft PowerPoint will be used to develop two types of narrated lectures. A compressed format lecture, based on Microsoft's advanced streaming format (ASF), and a Hypertext Markup Language (HTML) will be produced using the sound recorder that comes with various versions of the Windows© operating systems and PowerPoint 2000© and later. For a pedagogical explanation of how to use streaming lectures as part of an active learning environment to enhance a traditional classroom, please refer to session titled: "Enhancing a Face-to-face Course with Online Lectures: Instructional and Pedagogical Issues," to be presented at this conference on Tuesday, April 1, 2003, 9:50 a.m. – 10:50 a.m.

I have wanted to use active learning techniques in my classrooms, but could not find time, to cover course content and use the interactive learning techniques recommended by education experts (Bonwell & Eison, 1991). Active learning stresses the need for more interactions of students with instructors and others. Active learning uses practices such as immediate feedback, interactive learning, or collaborative learning for improving undergraduate education. All of these techniques rely on increased levels of student interaction to foster student motivation and learning, but can eat up large amounts of class time. Streaming lecture content to students before they come to class provides me with the opportunity to cover content and have time to use active learning techniques in class.

Since 1999, I have used courseware to teach 15 sections of on-line, face-to-face, and enhanced versions of courses. I consider an enhanced course to be one where activities have been selectively moved out of the classroom and on to the Internet to free up time for other classroom activities. When I began looking to take my lectures on-line, the first hurdle I faced was how to create web pages where my students could come for instruction. The Internet is made out of electronic bits and bites that need to be programmed or else they do not behave properly. I am no programmer, and for me the notion of learning to create web pages was an onerous and challenging notion. However, I found an easy solution to my problem. Courseware automates and simplifies the process of developing and delivering distance education courses. Courseware is a unified suite of Internet-based software intended to ease that burden. Each semester when I create the websites for my course sections, I use courseware created by my University (Indiana University Southeast).
University, 2001,a). Other commercially available courseware packages are readily available. See Indiana University (2001b) for a comparison of features among popular versions of courseware. In general, courseware contains a comprehensive tool set including such features as: e-mail, discussion forums (electronic bulletin boards), chat rooms, tests and surveys, and Internet research tools like search engines and library reference databases. According to creators of courseware (e.g., Indiana University, 2001,a; Blackboard, Inc., 2001), it may be used to create an on-line course or to complement face-to-face instruction.

**Courseware**

Teaching over the Internet requires a website. Students gain access to a course by using the Internet to connect to the course’s website. Luckily, the construction of websites has been automated by the use of courseware, i.e., Internet-based class management software. Courseware is a solution for creating Internet-based websites whether for use with distance education or face-to-face instruction.

Oncourse is Indiana University’s proprietary version of courseware. It is a highly integrated and interactive set of software tools. The University uses Oncourse to dynamically generate websites for each course being offered each semester. For each of the thousands of courses offered each semester, a website is generated which supports such features as: syllabus, schedule of classes, class roster, student and faculty profiles, a place to post projects and other written communications from the instructor, threaded discussion groups, chat rooms, course-mail, on-line testing & surveys, on-line grades, and Internet research tools. Readers are invited to browse the course layout by visiting the author’s on-line class as a guest at [http://oncourse.iu.edu/se/](http://oncourse.iu.edu/se/) enter username: ecause* and password: password.

Students are able to watch lectures online from within courseware, directly over the Internet from a server, or from CD-ROM’s. Figure 1 is a screen shot showing an Oncourse website for a section of my class. This screen shot shows a link to the publisher’s website for the textbook used in the course. Students can access the same lectures from a link to the school’s server or a CD-ROM playing on their own machine at home.

---

**Figure 1, Oncourse Link Out to Lectures on Publisher’s Website**

---

<table>
<thead>
<tr>
<th>Online Gradebook</th>
<th>Past or review students grades</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oncourse Test and Survey Tool</td>
<td>Create and administer tests and surveys</td>
</tr>
<tr>
<td>Department Tool Wizard</td>
<td>Select from a list of resources useful for your department</td>
</tr>
<tr>
<td>Library Tool Wizard</td>
<td>Select from a list of commonly used resources maintained by the library</td>
</tr>
<tr>
<td>Switch to Student Mode</td>
<td>View the class as it appears to a student</td>
</tr>
<tr>
<td>Faculty Tools</td>
<td>Access faculty tools for this or other courses</td>
</tr>
</tbody>
</table>

**My Profile** | Access your courses, bookmarks, notebook and more |

**Insite** | Access student registration information from inside |

**Oncourse Profile Search** | Search for public information about instructors and students |

**Change Oncourse Password** | Change the password you use to login to the Oncourse service |

**Oncourse Tests and Surveys (Student)** | Take and review tests and surveys |

**Tools**

**Erwin McGraw-Hill Organizational Behavior** | Go here for the online textbook |

**Library Catalogs**

**Books in Print (BIP)** | Comprehensive "catalog" of books currently in print |

**IUCAT** | The Indiana University Libraries’ Online Catalog |

**Library catalogs of Kentucky Metrovity Institutions** | University of Louisville, Bellarmine College, Spalding University, Spalding University, KY, New Albany Public Library, Public Library, Muncie Public Library, Lancaster Free Public Library,
Figure 2 is a screen shot that shows the contents of a lecture being streamed from the textbook publisher's website to a student's desktop. In all cases, narrated content can be presented to students on-demand.

**Figure 2, ASF Narrated PowerPoint Slide Show Streaming From Publisher's Website**

Compressed files employing Microsoft's advanced streaming format (.asf) were used. The advantage of .asf-formatted files is size and speed. The compression algorithm used with PowerPoint achieves a ten to one compression, reducing disk size of presentations by ninety percent. Disadvantages of an ASF files are its lack of clarity and that students cannot navigate back and forth through a streamed lecture. Part of this problem can be overcome by providing students with a CD-ROM version of the ASF presentation. Using a CD-ROM version of a presentation and Windows Multimedia Player 6.0 a student can browse back and forth through an ASF file.

PowerPoint can also be used to develop uncompressed slideshows in HTML format that have very good quality and all the features of a PowerPoint presentation such as links and transition. The disadvantage of HTML presentations is their large size.

**Recording Lectures**

Each semester, students receive narrated PowerPoint slide show lectures that serve as first-exposure lectures. Each
A lecture was generated based on scripts that followed the learning objectives of the textbook used for the course. Scripts were prepared for each lecture. The lectures were tightly integrated with materials in the book, so that at appropriate times, references were made in class and on the disks to pages containing material, exercises, and cases. These scripts were then used to generate PowerPoint narrations. To narrate on-line lectures, the recorder that accompanies Windows was used to record the scripts to create sound files (WAV format) that were embedded in PowerPoint presentations. (See figure 3.)

**Using the Sound Recorder**

Sound Recorder will record 60 seconds of narration, non-stop. To record narrations longer than 60 seconds, stop and start the recording. Each time the recording is stopped then started adds an additional 60 seconds of recording time to a narration. The content covered in an hour and 15-minute lecture, takes up much less narration time. In class, a lecture is frequently broken up with pauses. An instructor will rarely speak on the content of a lecture for the whole of the period. Based on my experience, expect for each hour of lecture material about 30 – 40 minutes of narration.

In terms of quality, to get the most out of Window's Sound Recorder, some features need to be set that depend upon the targeted playback rate. At higher recording rates, both sound fidelity improves and file size grows. Albeit improvements in sound quality will not be noticeable upon playback at slower rates. Because of bandwidth constraints, many users receive information over the Internet at much slower rates than others. Older dial up connections still operate at 28.8 kps, while users on fast access DSL or cable connections receive data up to ten times faster. When recordings are streamed to users at slower rates, playback quality will be reduced.

Figure 4 shows the Sound Selection Dialog Box for the Sound Recorder having been set to create sound files at a recording rate of 8,000 KHz, 8 Bit, Mono. If you plan slower Internet presentations (28.8 kps), Microsoft recommends an...
How to Develop Streaming Multimedia Lecture Presentations

Compressing Sound Files

Set the attribution field in the sound selection dialog box to 16,000 kHz, 16 bit, Mono if you plan on intranet (100 Kpbs) presentations. For reference, telephone quality is about 11,025 kHz, radio quality is about 22,050 kHz, and CD quality is 44,100 kHz. Setting the attribution field determines recording rates that affect both fidelity and file size of recordings. At the 16,000 kHz recording rate, files grow by 31kb/second. At this quality, ten lectures with 45 minutes of narration would occupy about 850 mega bytes of disk space. For reference, the size of a CD-ROM is about 680 mega bytes. These numbers are for uncompressed files.

Compressing PowerPoint Presentations

Later, we will talk about making the playback of your presentation appear the way it was created. To do so will require making a copy of your presentation available on a web server in HTML format. The disadvantages of HTML presentations are that they require the use of lots of server space and are not easily portable. Presentations can be made portable by publishing them as ASF files. PowerPoint 97 and later can publish ASF files that synchronize audio-visual PowerPoint presentations, so they can be played back on a network or on a student's home computer. Playback over the Internet happens when students point their web browsers to the URL address holding your presentation. The browser streams the presentation to the Microsoft Windows Multimedia Player.

PowerPoint makes ASF files by converting PowerPoint slides into JPEG images, associating a narration recorded for each slide as a WAV file, and compressing them all into a single ASF formatted file. Converting PowerPoint slides into an ASF file uses a compression algorithm to reduce file size. At the time the ASF file is published, the compression feature in PowerPoint gives the publisher control over the playback speed. This is necessary because many students at home still use slow dial up modems. Many problems caused by such narrow bandwidths can be avoided by publishing ASF files that stream as slow as 28.8 kps. All of this means that you will be making a trade-off between file size, network bandwidth, audio and image quality, and the amount of compression. Keep in mind when creating PowerPoint slides for later playback that a presentation can contain so much information that no amount of compression or size reduction will produce an acceptable product. In this regard, I have found that using minimal amounts of text accompanied by detailed voice narrations works best.

In the next step, you will be introduced to the process of embedding .wav format sound files in PowerPoint slides and compressing the PowerPoint slides together with the embedded WAV sound files into a single Windows Media file published as an ASF file. Compression algorithms are improving all the time. Right now, ASF files that stream at 28.8 kps achieve about a ten to one compression. A giga byte of audio and video can be reduced to about 100 mega bytes. File size and playback quality is dependent on the amount of information contained in a PowerPoint presentation and the target bandwidth of the ASF file. In the end, the best way to find an ideal recording rate and conversion rates is to tryout a few settings. I usually create several ASF versions of the same presentation, depending on where they will be played back — one version for playback over the Internet at 28.8 kps and another for playback on home computers at 100 kps. I record all my narrations at the higher narration rate to avoid having to make two sets of recordings.

Figure 4, Recording Sound Narration Using Windows Sound Recorder
To create ASF audio-visual files, sound files recorded with the Windows Sound Recorder are first embedded in each slide of the PowerPoint presentation. (See Figure 5.)

**Figure 5, Embedding Sound Narrations in PowerPoint Presentation**

Recording rate set at:
8,000 kHz, 8 Bit, Mono, 7 kb/sec
Altogether, about 1 giga byte of computer storage space was needed to hold all the lecture material for my course. Ordinarily, this much material would require two full CD-ROM and could not be sent over the Internet to students with slow dial up modems in an efficient manner. However, the material was later compressed for easy streaming over the Internet at 28.8 kbps or dissemination using CD-ROMs at 100 kbps. Each set of slides with attached sound files was run through a compression program add-on available from Microsoft download center (at: http://www.microsoft.com/downloads/) as part of its free Windows Media download (wmtool.exe). From the Start menu in Windows, run the Windows Media .exe file. This will extract it and make it available to be included in PowerPoint as an add-on tool. Running the Windows media add-on program from the Tools menu will add a Publish to ASF feature to the Tools menu of PowerPoint 97 and later. The Publish to ASF feature will allow PowerPoint presentations to be compressed from about 1 giga byte down to 100 mega bytes for playing at 28.8 kbps. The ASF files can easily be written to a CD-ROM for distribution or later loading to a server. To publish an ASF format PowerPoint presentation go to Tools and select the Publish to ASF (see Figure 5). This feature will combine embedded wave files and PowerPoint slides to produce one ASF file for each lecture.

Figure 5, Publishing ASF File from PowerPoint
After installing the wmtool.exe file and running Add-Ins, to publish .ASF formatted files, choose under: Tools/ Publish to ASF

Click to add title

Click to add subtitle

Readers are invited to browse and play course lectures on-line by visiting the website for textbook (Krietner and Kinicki, 2001) using Microsoft Internet Explorer © at http://www.mhhe.com/business/management/kreitner5e/student/olc/ch01lecture.mhtml.

Using HTML Formatted Files

To make playback of your presentation appear the way it was created, publish the presentation to a Web folder. This will require that you gain access to a Web server account at your University. Hypertext Markup Language (HTML) formatted files (a Web page) can be streamed from a server over the Internet with very high quality. After embedding sound files in a PowerPoint presentation a HTML version can be published that will play the narration when the HTML document is accessed over the Internet. The sound files and PowerPoint presentation are not combined into a single file, as happens when publishing ASF files; instead all files will be saved in a single subdirectory on to a dedicated server account for streaming over the Internet. To publish a presentation as a Hypertext Markup Language (HTML) to the Web, from the File menu, Save as Web Page to the appropriate server directory. This will place a copy of the presentation in Hypertext Markup Language (HTML) format (a Web page) on the Internet. Figure 5 displays a HTML lecture. Note the easy to use navigation bar on the right side of the screen. Students can use it to go back and forth to individual slides.

Figure 5, HTML PowerPoint Lecture
The command is flexible. It allows you to publish copies of the same presentation to different locations. Your Internet publication can be a complete presentation, a custom show, a single slide, or a range of slides. You can choose from a variety of browser formats to make your presentation available in, including Microsoft Internet Explorer 3.0 or Netscape Navigator 3.0.

Once you have published to the server, to provide students with access will require a link from a Web page to the HTML document. By clicking on the link, students will be taken to the presentation. Many features are supported in HTML presentations including: embedded sound files and videos, hyper-links to other documents, as well as transitions, swipes. Anyone who is thinking about creating a Web presentation should contact his or her system administrator to ask for permission before publishing. As I mentioned earlier, creating HTML documents in this way requires considerable disk space. A 20 – 30 minute presentation can easily occupy 50 - 100 mega bytes of server space, and lectures for a semester can easily require 2,000 – 4,000 mega bytes (1000 mega bytes equal 1 giga byte). As reference, the same 50-mega byte HTML presentation would be only about 5 mega bytes as an ASF presentation.

Conclusions

The Internet does offer unparalleled convenience and flexibility. Internet instruction versus face-to-face instruction should not be looked at as a tradeoff between utilitarian concerns and teaching effectiveness. Technology such as PowerPoint enables any instructor with just a minimum of expertise to tap the Internet as a means for distributing lectures. In a hybrid course, an instructor may use the flexibility of the Internet to its best advantage. The Internet’s greatest contribution to education may be as a tool for experimentation and innovation to improve teaching and learning.

References


NOTICE

Reproduction Basis

- This document is covered by a signed "Reproduction Release (Blanket)" form (on file within the ERIC system), encompassing all or classes of documents from its source organization and, therefore, does not require a "Specific Document" Release form.

- This document is Federally-funded, or carries its own permission to reproduce, or is otherwise in the public domain and, therefore, may be reproduced by ERIC without a signed Reproduction Release form (either "Specific Document" or "Blanket").